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1. Abstract 
 

This research focuses on the geomorphological mapping of the Central Baruth Ice Marginal Valley 
using LiDAR data, which was analysed in the Geographical Mapping program ArcGIS Pro 2.8.0. in 
combination with literature, satellite images and conventional topographical and geological data. As 
a result, a geomorphological map was created, which contains landscape forms at different scales, 
namely macro, meso and micro level. This research has been built on previous years' Bachelor 
research, where the geomorphological map on the east side will be extended by 5 x 2 = 10 km, and a 
specificity of minimum mapping size of fifty meters will be used. In addition, this research includes a 
specialization in which remains of the paleo-river (old dry river) the Goila have been traced. The Goila 
flowed in the Central Baruth Ice Marginal Valley but is currently canalized and named Hammerfließ. 
In the area, restoration of the canalized river Hammerfließ has taken place. Finally, the effects on 
biodiversity and flow location of the restored section of this river are discussed. Due to the COVID-19 
virus, it was not possible to physically carry out research/fieldwork in the area, therefore the area 
was analysed and mapped from a distance using LiDAR data, orthophotos, topographic maps, drone 
photos, literature and by the help of area expert Mr. Dr. W.M. (Thijs) de Boer.  
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2. Abbreviations 
 

Abbreviation Full name 
DEM Digital Elevation Model 
DTM Digital Terrain Model 
DSM Digital Surface Model 
LiDAR Light Detection and Ranging 
DRA Dynamic Ranging Adjustment 
RCH Relict Charcoal Heart 
RCS Relict Conflict Site 
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3. Introduction 

 
This study focuses on the geological mapping of the area around the town of Baruth in Brandenburg, 
eastern Germany. The research consists of two parts that are linked. The first part of the research 
focusses on the mapping of a strip of two (E-W) by ten (N-S) kilometres located on the western part 
of the town Baruth (see figure 1). This strip is part of a geomorphological map of five strips in total. 
The other strips are mapped by research colleague students of this Bachelor Research. This part of 
the study is a continuation of the Bachelor Studies from previous years. The strip is therefore on the 
west side adjacent to a strip that was mapped in a Bachelor Research from study year 2020 by 
Stef Zuidervaart. Mapping is carried out at different scales, namely macro (landforms larger than 1 
square kilometre) and is mapped at a scale of 1:100.000, meso (landforms larger than a 0.1 square 
kilometre to 1 square kilometre) and is mapped at a scale of 1:10.000 and micro (landforms smaller 
than 0.1 square kilometre) and is mapped at a scale of 1:1000 (Frank, 1987). 

 

  

Figure 1:  Left side: indication of the research area of Bachelor thesis student’s year 2021 on the map of Germany. Right: 
map of the whole research area of year 2021 in black outline. Research area Wesselman, 2021 in red outline. 
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This area is geomorphologically interesting to study because the genesis of this area took place as a 
result of two ice ages. As a result of these ice ages, the Central Baruth Ice Marginal Valley emerged 
with a terminal moraine on either side, both formed during adifferent ice age. During the Saale 
glaciation 300.000-130.000 years ago, the southern terminal moraine was formed and during the 
Weichselian glaciation 115.000-12.000 years ago, the northern terminal moraine called the 
Brandenburg terminal moraine emerged (see figure 2), (Juschus, 2001). Fluvio(glacial) processes after 
the end of the ice ages caused erosion and deposition of sediments, resulting in the emergence of 
the relatively flat Central Baruth Ice Marginal Valley. After the glaciers melted and the ice front 
‘retreated’ northwards, a dry but cold period started, which triggered the aeolian processes. The 
wind had free play on the soil and shifted the smaller sediments to form dunes. These dunes are 
present in the current study area (de Boer, 1995) and can be traced well at a distance using LiDAR 
data.  
 
With the advent of man, anthropogenic influences on the landscape have come. Logically, 
anthropogenic structures can be found in this area, for example, people started to build houses, 
roads and thus cities, they started to cultivate the land for agriculture, thus changing the Central 
Baruth Ice Marginal Valley over the years. There are also less common anthropogenic structures in 
this area, such as Relict Charcoal Hearts (RCHs) and Relict Conflict Sites (RCSs). RCHs are charcoal 
remnants in the soil from about 150 years ago, when people used charcoal to melt iron. In these flat 
forested areas (for wood supply), humans burned wood in the ground with limited oxygen 
concentration, whereby charcoal was produced. The remaining charcoal was buried and can still be 
found (Hirsch et al., 2017). RCSs are landscapes created as a result of military actions. During the 
Second World War, this area was heavily fought in the advance to liberate Berlin from the Nazis. In 
the southwest of the research area, there is also a Russian military training area called Heidehof-
Golmberg that was used for military training from 1952 to 1994 (Scholz, 1976). As a result, many 
traces of these military actions can be found in the landscape, such as bunkers, trenches, tank traps, 
explosives craters, tank tracks and other military structures (de Nobel, 2020). 
 
 

Figure 2: schematical image of the glacial series is "a typical spatial sequence of glacial forms created by ice and its 
meltwaters and consisting of loose material". (Glawion et. al. 2009, chap. 2.8.4.) This shows how the landscape 
genesis of the research area took place. In the current study area, the young moraine area (Jungmoränengebiet) lies in 
the north. South of this is the Central Baruth Ice Marginal Valley (Urstromtal). The southernmost part is the old 
moraine area (Altmoränengebiet). 
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In 1992, Mr. Dr. W.M. (Thijs) de Boer geomorphological mapped this research area by means of 
fieldwork and hand-drawn drawings. However, nowadays there are additional tools for accurately 
mapping this area. Thereby, this research focuses on the detailed geomorphological mapping of the 
Baruth Ice Marginal Valley and research the above-described geomorphological processes by using 
LiDAR data, orthophotos, topographic maps, drone photos, literature and by the help of area expert 
Mr. Dr. W.M. (Thijs) de Boer, which will be analysed and mapped in the Geographical Mapping 
program ArcGIS Pro 2.8.0. This research will build on previous years' Bachelor research, where the 
geomorphological map on the east side will be extended by 5 x 2 = 10 km (see figure 1 in black). And 
a specificity of minimum mapping size of 50 meters will be used, this means that relevant objects 
bigger than 50m x 50m are mapped. Each student is responsible for an area strip of 5x2 kilometres 
(see figure 1 in red 1) in the research area, although the mapping and analysis of different landscape 
structures is divided among the students, they have mapped them in the whole research area of year 
2021. 
 
The second part of the research was done after the mapping of the area around Baruth was finished. 
This part of the research aims to investigate paleo-rivers which have been altered as a result 
of human interference in effect of channelling the old river Goila. The aim of mapping these paleo-
river systems is to find out whether a project financed by the Brandenburg Land Agency to restore 
the Hammerfließ to its former state was successful.  For this, it is important to know where the river 
flowed, so this research will also focus on tracing the paleo-river Goila. 
 
Due to the COVID-19 virus, it was not possible to physically carry out research/fieldwork in the area, 
therefore the area has been analysed and mapped from a distance using LiDAR data, orthophotos, 
topographic maps, drone photos, literature and by the help of area expert Mr. Dr. W.M. (Thijs) de 
Boer.  
  
This information has led to the following main research question and sub questions:   
 

Research Questions 
 

Main research question  
   
How can the area around Baruth be mapped remotely with ArcGIS Pro by using LiDAR data and - by 
using this mapping which traces of the paleo-river Goila (which was partly canalised into the 
Hammerfließ) can still be found there?   
   

Sub questions   
• How can the research area be mapped using LiDAR data, satellite images and conventional 
topographic and geological data?  
• What are the advantages and disadvantages of this remote method compared to field 
surveys?   
• What did the Brandenburg Land Agency do to alter/restore the Hammerfließ to a more 
natural state, and how did this contribute to the natural value in this area?   
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4. Methods 

As mentioned in the introduction, this study aims to create a geomorphological map of the research 
area, divided on macro, meso and micro level. This geomorphological map has been created in 
Geographical Mapping program ArcGIS Pro 2.8.0 by use of LiDAR data, orthophotos, topographic 
maps, drone photos, literature, and the help of area expert Mr. Dr. W.M. (Thijs) de Boer.  

The research started with reading the literature about the area and loading the data into ArcGIS 
using the Building an APRX Roadmap made by the 2020 bachelor thesis students (appendix B). This 
Roadmap shows how a Digital Elevation Model can be made from LiDAR data and how various Web 
Map Services (WMS) can be loaded into ArcGIS. Also, research group year 2021 has made additions 
to the Building an APRX Roadmap, in areas where this was needed. The roadmap describes how to 
create LiDAR derived products from the DEM in ArcGIS, such as the Slope, Hillshade, Contour, and 
Aspect map, which contains a lot of geological information about the landscape. 
 
The most important data source for this research was LiDAR data (light detection and ranging) which 
is an optical remote-sensing technique that uses laser light to densely sample the surface of the 
earth, producing highly accurate x,y,z measurements. LiDAR, primarily used in airborne laser 
mapping applications, is emerging as a cost-effective alternative to traditional surveying techniques 
such as photogrammetry. LiDAR produces mass point cloud datasets that can be managed, 
visualized, analysed, and shared using ArcGIS. (Esri, z.d.)  
 
LiDAR data is an innovative data source for monitoring and mapping large areas in the field which in 
the past had to be done by field observations, which was a very time and resources intensive job to 
do (Faux et al., 2009). LiDAR data is a very useful data source for remote sensing and 
geomorphological mapping (Ninfo et al., 2015). The improved vertical and horizontal resolution is 
special to the LiDAR data and makes this data very useful for mapping on macro, meso and micro 
scale, which makes it a very suitable data source for this research (Carter et al., 2012). The LiDAR 
datasets that are used for this study have a point density of 3 points per square meter and thereby a 
grid width of 1 meter (DGM1) but this point density gave the possibility to create a DEM with a grid 

with of 0.5 meter and vertical accuracy 30 centimetres (Stender, z.d.) and makes the LiDAR data 
accurate enough to see height differences of several decimetres. One of the most distinctive signs 
of paleo-river systems is that they are often several decimetres lower than the surrounding ground. 
So, this vertical accuracy makes LiDAR data as suitable for tracing paleo-rivers as using field 
observations. 
  
Using the LiDAR data, a Digital Elevation Model (DEM) was made, which is very useful for detecting 
height differences and thus for tracing paleo-rivers. A Digital Elevation Models (DEM) is a topographic 
model of the bare Earth that can be manipulated by computer programs like ArcGIS Pro. The data 
files contain the elevation data of the terrain in a digital format (raster) which relates to a rectangular 
grid (Koning, 2017). The intervals between the grid points are always georeferenced to a geographic 

coordinate system (Singh, 2020), which in the case of this research is ETRS 1989 UTM Zone 33N for 
X, Y (easting and northing) and DHHN92 for Z (height). 
   
In data derived from drone images and video’s other signs of paleo-river systems may become 
visible, such as differences in colour after ploughing may indicate ground moisture differences which 
might indicate that a paleo-river has flown there which can be seen on drone photos and 
orthophotos.  
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The geomorphological map was created using a merged legend from studies by Pachur & Schulz 
(1983) and Frank (1987). These legends originate from studies from the analogue era and were 
therefore only digitally available as PDF scan. These legends have been digitalised for ArcGIS by 
Schadee (2020) and can be found in. In this research they created a legend with unit codes for every 
different geomorphological landform from 1 to 16.  

Creating the Soil Type map for research area 2020 and 2021 

In this research a Soil Type map was created to give a clear 
overview of the upper soil types in the study area of this year 
(2021) and last year (2020). Due to the COVID-19 pandemic, field 
work has not been possible, so determining the soil types in the 
field has not been possible. Therefore, a WMS map (Bodenarten 
und Substrate – INSPIRE View-Service (WMS-LBGR-BOARTSUBSTR)) 
of which the Bodenarten Oberboden KA5 (Soil types Topsoil) sub-
map was used (see figure 3 for path and legend). This sub-map was 
chosen because it corresponded to the legend unit 1 used for soil 
types in this research (Schadee, 2020, Pachur & Schulz, 1983 & 
Frank, 1987). The legend of the WMS distinguishes 13 different 
legend units (Figure 3), but in the study area only the following 4 
occur; Loamy Sand (schwach lehmiger Sand), Lowland Peat 
(Niedermoortorf), Sand (fine) (Reinsand/Feinsand Mittelsandig)) 
and Sand (medium fine) (Reinsand /mittelsand feinsandig). These 4 
different soil types are digitalized as accurately as possible from 
the WMS map as polygons. 
 

Creating Slope Class map for research area 2020 and 2021 

In this research a slope class map was created to get a clear view of the slope classes divided into 4 
classes, according to the used legend (Schadee, 2020, Pachur & Schulz, 1983 & Frank, 1987). The 4 
slope classes are ≤ 2°, > 2° - 7°, > 7° - 15° and > 15° (See figure 4).  
 
The slope class map is derived from the DEM which is based on 
LiDAR data. The slope tool in ArcGIS Pro calculates the slope or 
steepness for each cell in the grid out of the hight of the 
surrounding cells, so for the slope calculation of one cell, 3x3 cells 
are used (Esri, z.d.).  
 

  

Figure 3: path to and legend of WMS map 
(Bodenarten und Substrate – INSPIRE View-
Service (WMS-LBGR-BOARTSUBSTR)), 
Bodenarten Oberboden KA5 (Soil types Topsoil) 
sub-map which was used for digitalization of 
the soil type map. 

Figure 4: legend of the soil class map according to 
the used legend of Schadee, 2020, Pachur & Schulz, 
1983 & Frank, 1987 
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Tracing paleo-rivers 
On the basis of a georeferenced map (Urmeßtischblatt map of 1841), DEM, satellite photographs and 

cross-sectional profiles obtained from the DEM data, the ancient flow of the paleo-river Goila could 

be traced. It can be clearly seen that the Goila originally flowed south of today's Hammerfließ. The 

DEM is very useful for tracing the paleo-river in combination with the Dynamic Ranging Adjustment 

(DRA) function in ArcGIS Pro. The DRA function adjusts the symbology of the DEM to the values in the 

image. The highest point in the image is given the reddest colour and the lowest point in the image 

the greenest colour. This ensures that small height differences are clearly visible, and this is therefore 

very useful when tracing paleo-river systems. Paleo-rivers can be recognised by meander-shaped 

depressions in the surface that can be recognised as (darker) green in the DEM. The potential paleo-

river was then explored using various methods. A cross-section was drawn. A U-shaped depression in 

the landscape is characteristic for a paleo-river. Even in cultivated landscape, where for example 

ploughing has taken place, a small depression in the landscape is often still visible. Next, a satellite 

image was analysed. In case a paleo-river lies below an area with vegetation, mostly it is very difficult 

to find traces of it. When a landscape has been ploughed, a discolouration pattern in the landscape 

may indicate a paleo-river. This discolouration is the result of a different moisture content in the soil, 

due to a difference in soil material that has been left behind by the paleo-river. 

Data management 
Pre-processing: 

For the first part of the research, the creation of a geomorphological map, the geodatabase of the 

Bachelor Thesis students of the year 2020 was used as a basis. In this geodatabase a 

geomorphological map of the research area of the Bachelor Thesis students 2020 is stored. This map 

was made using the legend of Pachur & Schulz (1983) and Frank (1987) which was digitalized by 

Schadee (2020). This data is made available via the cloud platform Surfdrive. Other data was also 

available on Surfdrive, such as literature, photos of previous field research and drone photos and 

videos of the research area. The Surfdrive was also used for data exchange within the Bachelor Thesis 

Group 2021 and with supervisor W. M. de Boer. 

Post processing: 

Data management in this research was done by using the FAIR principles. FAIR stands for findability, 

accessibility, interoperability, and reusability. The findability of the data is ensured by uploading it on 

the Figshare platform provided by the University of Amsterdam, where scientific publications and 

data are stored. The research paper receives a unique DOI code, which makes the research paper 

permanently available on the world wide web. The geodatabase with all data layers from ArcGIS Pro 

of the Bachelor Thesis Students of year 2021 and previous years was also uploaded on Figshare. 

These layers are individually tagged with metadata to show how the data was created and what 

sources were used to create it. This also ensures that the data can be used separately. The research 

report and maps will also be uploaded to gis-studio.nl. The data and the research report and the 

main maps will therefore be accessible to everyone on the internet, on Figshare and gis-studio.nl. 

The data is interoperable because all data layers can be used separately and all have metadata, 

making them compatible with data specific to a part of this study. For example, when research is 

done into macroforms in this area, only this sublayer can be extracted from the geodatabase because 

all layers have their own metadata. Because the metadata describes well how the data came about 

and which sources were used for this, the data can be easily reusable for follow-up research. For 

future Bachelor Theses, the data has been uploaded to the Surfdrive, where the data from previous 

years can also be found, so that all the data in a cluster can be used immediately. 
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5. Results 
 
In this part of the research all the mapped legend units in strip 1 of the research area will be 
substantiated by use of found literature and data. This will be done starting with the macro 
structures, thereafter the meso structures and finally the microstructures. Strip 1 will be described 
schematically from north to south by hand of the legend units. 
 

Macro  

 

Baruther Sander 

In the most north western side of the research area the 
Baruther Sander was mapped. In the legend the Baruther 
Sander can be found as Unit 13.6: Fluvioglacial accumulative, 
sander in the legend. An alluvial fan is characterised by 
sediments like gravel, sand and even smaller sediments and a 
slope of between 1.5 and 25 degrees (Morgan et al., 2014). The 
dominating substantial material of the Baruther Sander is 
medium fine sand (unit 8.22 in the legend) which comes from 
the Brandenburger Terminal Moraine, which was formed during 
the Weichselien ice age. When the ice melted and the ice front 
‘retreated’, the meltwater created fluvioglacial processes that 
washed water off the terminal moraine, taking material with it. 
This material was then deposited, and the Baruther Sander was 
formed. The Baruther Sander is characterised by a gentle slope, 
see figure 5. This picture was taken from the origin in the north, 
southwards across the alluvial fan and clearly shows a gentle 
downward slope (see figure 5).  The border of the Baruther 
Sander was determined using the Digital Elevation Model 
(DEM), which shows a clear decrease in height. Down the slope, 
the surface has a much smaller slope and is almost flat, which 
characterises the Baruth Ice Marginal Valley. The height drop 
between the Baruther Sander and the Baruther Ice Marginal 
Valley could be determined from Z-values (height values) of LAS data points on the sander and in the 
valley. The height drop between the sander and the valley is 14 metres over 50 metres (see figure 6).  

Figure 6: Cross-section of the transition from the Baruther Sander to the Baruth Ice Marginal Valley (Urstromtal) with a 
height difference of 14m over a length of 50m. 

 

Figure 5: Photo taken from the northern part (at 
the origin) of the Baruther Sander towards the 
south. The photo shows a slight slope, which is 
characteristic for an alluvial fan. Photograph 
taken by W. M. de Boer (2013) during field 
research. 
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Baruth Ice Marginal Valley (Urstromtal) 
The Baruther Sander is surrounded by the 

Baruth Ice Marginal Valley which can be found 

in the legend as Unit 13.7: Fluvioglacial erosive 

valley (polygon feature). The valley was formed 

as a result of erosive fluvioglacial processes, 

whereby the ice melted, and the meltwater 

eroded the valley. The surface of the valley is 

flat, so the water had a low flow velocity or 

even partly remained, and the soil became 

wet. This resulted in small sediment particles 

being deposited and the landscape even 

becoming swampy. The dominant soil type in 

the area is therefore Unit 8.13: Lowland Peat. As 

a result of the erosion of the valley, several river 

terraces were formed. In Juschus' study (2001), four river terraces were observed in the valley. In the 

study by Gelderen (2021), three river terraces (with height of terrace 1:  > 54.5m, terrace 2: 54.5m – 

54m and terrace 3: < 54m above sea level) were observed in the current study area by means of an 

analysis of the Digital Elevation Model (DEM) with a modified visualisation method. In figure 7 from 

the Juschus 2001 study, the fluvial sand layers can also be clearly seen through a cross-section of the 

valley soil. 

  

Figure 7: Parallel-stratified sands in the glacial valley north of 
Klein Ziescht (Juschus, 2001, p. 89) 
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Ground Moraine  
In the southernmost part of the survey area, south of the 

Baruth Ice Marginal Valley is a ground moraine which can 

be found in the legend as Unit 13.4: Glacial accumulative 

ground moraine (polygon feature). The ground moraine 

was formed in the Saale Ice Age as a result of glacial 

processes. The allochthonous material that characterises 

the ground moraine was brought from more northerly 

areas. A ground moraine is often characterised by the 

dominant soil type, boulder clay, where large boulders can 

be found that could only have been deposited as a result of 

glacier movement. During field research, a ground moraine 

can therefore be easily identified because large boulders 

can be found in the soil. However, due to COVID-19 field research was not possible. The evidence for 

the ground moraine in the southern part of the research area is therefore taken from images from 

previous field research.  To the south-west of the village of Klein-Ziescht there is footage of a cross-

sectional profile of the soil (see figure 8). The cross section clearly shows different silt layers. Silt is a 

very fine soil type, which can only be formed when sediment 

particles are deposited in (almost) standing water. However, 

these layers are sloping. This indicates propulsion by ice and is 

therefore evidence of the border of moraines. South of the 

study area lies the village of Groß-Ziescht. At the north-east 

there is also, a cross-section is visible photographed by Dr W.M. 

de Boer in 2014, with soil material that indicates a bedrock 

moraine and a terminal moraine. The photo shows a boulder 

under the dune sand (which was later deposited over the 

moraine). This boulder can also only have been deposited here 

as a result of glacial processes. This also indicates a ground or 

terminal moraine (see figure 9). 

Subsequently, the edge of the ground moraine was determined 

on the basis of similar optical structure and height difference. 

The height difference between the valley and the ground 

moraine is about 15 metres over a distance of 350 metres. The 

area between Klein-Ziescht and Groß-Ziescht and the 

corresponding structure around it is thus assumed to be 

moraine from the Saale glaciation.  

  

Figure 8: cross-sectional profile of the soil 

showing an uplifted silt layer near the village 

Klein-Ziescht (Juschus , 2001,  p. 44) 

Figure 9:  boulder under dune sand near 

the village Groß-Ziescht photographed by 
W.M. de Boer (2014) during field research. 
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Meso 

Hydrology 
In the north of the Baruth Ice Marginal Valley flows the river Hammerfließ, which rises in the city 

park of Baruth . This river was formerly called the Goila but has been canalised into the Hammerfließ. 

There are also canals dug parallel to the Hammerfließ, which are filled by the Hammerfließ. These 

canals were dug to supply water to the fields intended for agriculture. 

However, by canalising the Hammerfließ, man has disturbed 

the natural hydrology of the area and the Hammerfließ has 

regularly run dry. For this reason, the Brandenburg Land 

Agency has intervened and drawn up a plan to bring the 

Hammerfließ back to a more natural state. In 2013 and 2014, 

the plans were executed. The aim of the project was to 

restore habitats for aquatic animals and plants and to 

stabilize the water balance in the area. To achieve this goal, 

a number of adjustments have been made to the canalised 

Hammerfließ. For example, flow paths have been extended 

and two new water loops have been constructed. In 

addition, new floodplains with loops have been created 

north of the Hammerfließ where the soil must be moist. Low 

water channels through the floodplain are intended to keep 

the soil wet. Also, many culverts under roads have been 

replaced by bridges or free passages. Finally, the riverbed 

has been raised. It is striking that all adjustments were made 

on the northern side of the present Hammerfließ. 

(Flächenagentur Brandenburg GmbH, & Szaramowicz, M., 

2014) 

In strip 0, 1 and 2 of the Bachelor Thesis year 2021, parts of paleo-river sections were found and 

proven using different methods. 

At location A (see figure 10), which is located in strip 0, close to the border with strip 1, a section of 

the paleo-river Goila was found. First, the georeferenced map (Urmeßtischblatt map of 1841) shows 

that the Goila must have flowed here approximately. A clear depression pattern in the landscape can 

also be seen in the DEM. This pattern is shown in Figure 11 as Goila location A. This line feature is 

drawn based on approximation of the DEM.  Also, on the cross-section a depression in the landscape 

of about 50 centimetres can be seen, which indicates a paleo-rive (see figure 11).  

Figure 11: The canalised Hammerfließ (drawn on base of WMS BB-BE DTK10 Farbe)  and the former flow of the paleo-river 
Goila through the research area drawn from the georeferenced map (Urmeßtischblatt map of 1841) and drawn from an 
approximation of the DEM (Goila location A). The location of cross-section A shown in Figure 10 can be seen. The 
background is the DEM, which shows the characteristic structure of a paleo-river. 

Figure 10: Cross-section Goila location A with 
the length of the cross section in metres on 
the x-axis and the height above sea level in 
metres on the y-axis. 
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At location B (see figure 12) further downstream, also 

located in strip 0, another evidence for the course of the 

Goila has been found. Here again, a depression in the 

landscape can be seen on the DEM. A cross-section was 

made here as well (see figure 13). Here the U-shape that is 

characteristic of a paleo-river is less well visible. Again, the 

cross-section shows a depression in the landscape of around 

50 centimetres. However, this depression is much narrower 

than the one at location A.  

 

Figure 13: Cross-section Goila location B with the length of the cross section in metres on the x-axis and the height above sea 
level in metres on the y-axis 

  

Figure 12: The canalised Hammerfließ (drawn on 
base of WMS BB-BE DTK10 Farbe) and the former 
flow of the paleo-river Goila through the research 
area drawn from the georeferenced map 
(Urmeßtischblatt map of 1841) and drawn from an 
approximation of the DEM 
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Unfortunately, the satellite picture does not show a clear pattern of a paleo river at both locations 

(see figure 14). The reason for this may be that the land has been ploughed too often, causing the 

different types of soil to mix and thus have the same capacity to retain water. 

 

Figure 14: The canalised Hammerfließ (drawn on base of WMS BB-BE DTK10 Farbe) and the former flow of the paleo-river 
Goila through the research area drawn from the georeferenced map (Urmeßtischblatt map of 1841) and drawn from an 
approximation of the DEM (Goila location A and B). The location of Goila Cross Section A shown in Figure 10 and Goila Cross 
Section B shown in Figure 12 can be seen. The background is a satellite image (WMS BB-BE DOP20c), which unfortunately 
does not show the characteristic structure of a paleo-river 

An explanation for this is that the Goila used to flow through an area where nowadays there are 

agricultural fields. The Brandenburg Land Agency could not clear these agricultural fields, so the 

adjustments were made to the natural land to the north. However, this has resulted in the fact that 

the Hammerfließ still does not have a stable water level and regularly runs dry (W.M. de Boer, 

personal communication, May 2021).  
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Parabolic dunes and ridges 
In the northwest of the study area dunes were formed. These processes took place when the ice 

sheets retreated, and drought followed, and the barren soil was exposed to aeolian processes. The 

dunes in the study area have a parabolic shape and are therefore called parabolic dunes. This 

parabolic shape is caused by the wind blowing from west to east and thus depositing the material in 

parabolic form. These dunes were also identified in a study by de Boer (2000). The part of the dunes 

in the survey area are known as the Tütschenberge and the dunes continue to the west beyond the 

research area to beyond Horstwalde (de Boer, 2000) see figure 15.  The dominant soil type in the 

area is medium fine sand (Unit 8.22). The dune ridges were also mapped in this study and will be 

discussed further in the microstructures section.  

Valleys and small drainageways 
In the south of the study area, clear drainage incision patterns can be seen due to flowing water. The 

water flows down the moraine towards the lower valley and has caused erosion. These can be found 

in the legend subdivided into different sizes and shapes of incisions as Unit 5: Valleys and small 

drainageways (line feature). In this area, these dry valleys are also known as Rummel. 

  

Figure 15: Ridge lines of the dunes near Horstwalde (design and drawing: W. M. de Boer using the topographic maps 
1:10,000): 1- Ridge lines of the dunes (smaller dunes not shown), 2 - Height (in metres above sea level). (Boer, 2000, p. 62) 
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Micro 

Relict Charcoal Hearts (RCH’s) 
In previous research, relict charcoal hearths have been widely studied in the area of the Baruther ice-
marginal valley. Previous undergraduate and graduate students, as well as researchers from Cottbus 
University, for example, have studied these landscape forms in this area. In the past, researchers at 
Cottbus University manually traced 1500 RCHs by automatic analysis and fieldwork in the area 
around Luckenwalde (Wijkhuizen, 2018). In this research it became clear that the RCH’s where clearly 
visible on maps derived from LiDAR data. The RCHs had some distinct features that could be analysed 
remotely by using LiDAR data in ArcGIS pro. Characteristically, the RCHs have an elliptical elevation 
difference from the rest of the surface with diameters ranging from 6 to 28 meters. The difference in 
elevation is particularly well visible on the hillshade map, based on a Digital Elevation Model (DEM) 
derived from LiDAR data. Another specific feature of the RCHs is that they are most often found 
in/under wooded areas. It has never been proven that fewer RCHs have been located in open fields 
(Wijkhuizen, 2018), but it is plausible that due to man-made land cultivation such as ploughing, it is 
no longer possible to trace them. Another important argument for the presence of RCHs in the study 
area, is that in the past a lot of iron was smelted in this area which required charcoal which was 
created in the RCHs. 
 
In this study, a hillshade map of the study area was created on 
which the RCHs can be clearly seen. Validated RCHs from the 
adjacent research area of the Bachelor students from the year 
2020 were observed (see figure 16). The observed RCHs were 
validated before the COVID-19 pandemic during physical 
fieldwork (Burger, 2019). Here we took the characteristics of 
these using the measure tool in ArcGIS Pro to determine the 
diameter. Based on this characteristic shape and cross section, 
the current study area was analysed. When a matching structure 
was recognized in the landscape, we checked to see if it was in a 
forested area using satellite imagery obtained from a Web service 
in ArcGIS Pro called WMS BB-BE DOP20c. When it was under a 
forested area, it was mapped as a potential RCH. When this was 
not the case, the landscape form was discussed with the rest of 
the research group and when convincing arguments were made, 
it was mapped as such. Unfortunately, as a result of COVID-19, 
validation of the RCHs during field research was not possible. 
 

Military objects or Relic Conflict Sites (RCS’s) 
Another notable landscape form is one that has been formed as a 
result of human influences. This is because in the southwest of the research area lies a military 
training area which was utilised by the Soviet army from 1952 until 1994, named Heidehof-Golmberg 
(Scholz, 1976). Until 1994, the area was completely closed to outsiders. The area was mainly 
practiced with air shooting and aerial bombing in the area. They trained with Rifles, calibres ranging 
from 12.7 to 37 mm were used, as well as bombs of various calibres (Truppenübungsplätze, z.d.). 
Currently, it is possible to walk in the area, however, the footpaths are marked with bollards in order 
to guide the walkers safely through the area. However, entering the area is always at your own risk, 
due to the danger of exploding relic bombs. 
  

Figure 16: Visualisation by using a 
hillshade map of characteristic mapped 
RCHs. The elliptical landscape forms can 
be clearly seen. 
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In various previous research it became clear that an effective method to discover RCS’s is using a 
hillshade map symbology, of a Digital Elevation Model (DEM), derived from LiDAR data (de Nobel, 
2020, Schriek & Beex, 2017; Juhász & Neuberger, 2016; Juhász & Neuberger, 2015) when this data 
was combined with physically taken photographs and satellite photographs, the shapes of different 
RCSs can be well distinguished. The above-named literature describes that with the help of the DEM 
and satellite photographs, the following RCSs can be remotely detected; above and below ground 
bunkers (as foxholes and roadside bunkers), trenches, bomb craters, target structures, remains of 
camps and tank tracks (de Nobel, 2020). However, with the currently available resources, which do 
not include physical fieldwork, only foxholes, roadsides, trenches, tank tracks and undefined military 
objects have been found in this research area. It is also likely that there are RCSs dating back to the 
Second World War in the study area. In the research area, a 
bloody battle was fought where the Allied troops took over Berlin 
from the Germans. So, foxholes, roadsides, trenches, and tank 
tracks were also found outside the training area. 
 
Foxholes: The foxhole bunkers are also often recognisable by their 
square shape, but these are not located on the road. The foxholes 
are most often found in wooded areas, because in agricultural 
fields they are often ploughed, so that the bunkers are no longer 
visible. The bunkers often have a size of several metres.  The 
square shape that can be seen on the hillshade comes from the 
scooped-up soil and placed as an embankment, which formed the 
base of the bunker. The bunkers were often several decimetres 
deep and provided protection for soldiers, goods and sometimes 
vehicles. (see figure 17)  
 
Roadsides: The roadside bunkers, as the name suggests, are 
bunkers located near the road. They often have a rectangular 
shape with an opening on one of the sides where goods, people 
or vehicles could enter the bunker. Often the bunkers are 
arranged in a formation along the road (see figure 18). The 
elevation and the clear entrance to the bunkers are clearly 
visible on the hillshade DEM. The above-described 
characteristics for the roadside bunkers, have been examined in 
the research area of the students from the year 2020 (de Nobel, 
2020) and thus in the current research area we looked for similar 
characteristics in the landscape forms and mapped them.  
 
  

Figure 17: Visualisation of a mapped foxhole bunker 
in research area of Wesselman (2021) west of 
Baruth. Left visualisation: hillshade map, middle 
visualisation: satellite photo, right visualisation: 
DEM. 

Figure 18: Visualisation of several mapped roadside 
bunkers in research area of Wesselman (2021) west 
of Baruth. Left visualisation: hillshade map, middle 
visualisation: satellite photo, right visualisation: DEM. 
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Fire trenches: Fire trenches can also be found in the research area. Trenches are line-like dug-out 
landscape forms. Another characteristic of the trenches is that they are dug in a zigzag shape. The 
trenches can be 10 to 100 metres long, are only 0.6 to 1 metre 
wide and are between 0.5 and 2 metres deep observed in the 
DEM. The trenches served as protection for infantry soldiers who 
could shoot at the enemy from here. The zigzag lines through the 
landscape are again clearly visible on the hillshade map (see 
figure 19). The reason the trenches have a zigzag shape is to 
protect the trenches against explosives and shrapnel. The 
explosion will only do damage in the hit zigzag. It also provides 
protection if an enemy soldier penetrates the trench, as he 
cannot immediately shoot through the entire trench. 
 
 

Tank tracks: A remarkable landscape feature in the research area is that there are many indications 
that a former tank route that runs through it from the Baruth Bahnhoff where the tanks were 
delivered by trains, into the Heidehof-Golmberg training area. These former tank tracks are still 
clearly visible on the hillshade. Also, you can see on the WMS BB-BE DTK10 Farbe that there is a 
street named after this tank track, namely the ‘Panzer Straße’. Also, in a drone photo taken from the 
southern part of Paplitz (see Figure 20), a clear line of discolouration can be seen in the extension of 
the Panzer Straße through a field. This again is an argument for a tank track because the tracks in 
combination with the weight of the tank have a high ploughing capacity on the ground. The 
discolouration in the soil can be explained by an underlying layer that has risen to the surface, with a 
higher capacity to retain moisture, which explains the darker strip in the landscape. Under the 
wooded area north of the Panzer Straße, the hillshade shows that the tanks did not follow the Panzer 
Straße but they did go straight through the woods. The two line-shaped discrepancies are clearly 
visible under the vegetation, but validation in the field would be necessary to prove this plausibility 
(see figure 21). 
 

Figure 19: Visualisation of a mapped fire trench in 
research area of Wesselman (2021) west of Baruth. 
Left visualisation: hillshade map, middle 
visualisation: satellite photo, right visualisation: 
DEM. 

 

Figure 20 Drone photo Kemlitzer Str. 6, 15837 Baruth/Mark, Germany, made by W. M. de Boer (2017 taken in north-eastern 
direction). Discolouration in ploughed field visible indicating former tank track. Panzerstraße marked by the red arrow. The 
discolouration can be seen between the two red lines. 
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The tanks used to not take the roads because their 
weight would make the roads unusable for cars. Due to 
the poor manoeuvrability of the tanks, they always took 
the same route mainly over fields, but also through 
mildly wooded areas. The remaining tank tracks are 
therefore recognisable by the straight lines with small 
corners as deflections because the tanks could not turn 
sharply. 
 
 
 
 
 
 
 
 
 
Undefined military objects: The remaining military 
structures, consists of several different landscape forms that 
were presumably formed as a result of military interventions 
in the landscape. The name undefined was chosen because 
physical validation was not possible during fieldwork, so the 
evidence for this cannot be given. These include the remains 
of above-ground bunkers, encampments, and large bomb 
craters. Therefore, it cannot always be concluded whether 
the structures are of military origin or whether they were the 
result of other human interventions. It is therefore assumed 
that these structures in the Heidehof-Golmberg training area 
are military structures, because in the present day this is a 
nature reserve where not many human interventions are 
made due to the danger of explosion of relic bombs and 
grenades. (see figure 22) 
 

  

Figure 22: Visualisation of a mapped undefined 
military structure in research area of Wesselman 
(2021) west of Baruth. It is expected that this 
visualisation shows a former bunker, but 
validation through field research was not possible. 
Left visualisation: hillshade map, middle 
visualisation: satellite photo, right visualisation: 
DEM. 

Figure 21: Visualisation of the mapped former 
tank track in research area of Wesselman (2021) 
west of Baruth. Left visualisation: hillshade map, 
middle visualisation: satellite photo, right 
visualisation: WMS BB-BE DTK10 Farbe map. 
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6. Conclusion 
 

Sub questions  
 
How can the research area be mapped using LiDAR data and conventional topographic and geological 
data, but without field research?  
 
In this research, the mapping of the geomorphology of the study area was done using a different 
method than the conventional one, in which field research plays a major role. Due to COVID-19, a 
physical visit to the study area was not possible. The research therefore took place entirely at a 
distance. In this study, literature, and images from previous studies (where field research was 
possible) were used. However, the main source of data of this research was from the LiDAR data, 
which was handled in ArcGIS Pro. The LiDAR data was a particularly important new addition because 
this is a new technique, and this area has been extensively studied using the conventional method 
but has never been studied using LiDAR data. The LiDAR data makes it possible to detect certain 
landscape structures with a length width and height of a few decimetres that are almost impossible 
to determine by field research. The point cloud has a density of 3 LiDAR points per m2 which resulted 
in the DEM data has an accuracy of 5 decimetres length and width and 3 decimetres in height. Drone 
footage was also used, showing structures in the landscape that could then be examined in more 
detail using other sources. Finally, existing Web Map Services were used, whereby different maps 
could be superimposed when geomorphologically mapping the research area. 
 
 
What are the advantages and disadvantages of this remote method compared to field surveys?   
 
The remote method has many advantages, but there are also disadvantages that cannot be ignored. 
As discussed in Part 1, LiDAR data is a very accurate source that can detect previously undiscovered 
landscape structures. This has many advantages, especially on a micro scale, as structures as small as 
half a metre in size can be observed. However, the method used also has advantages on a micro 
level, for example Web Map Services can be used for the detection of macro structures and for the 
substantiation of the classified structure. In particular, the combination of information from previous 
research, which did take place, with the research using LiDAR data has ensured that many structures 
could be determined. The shape of certain structures could be extracted from literature and it was 
logical whether these occurred at a certain location, such as a Roadside Bunker in the Heidehof-
Golmberg training area. If a recognisable structure of a Roadside Bunker in the Heidehof-Golmberg 
training area was then observed in the Digital Elevation Model, it could logically be assumed that this 
was actually one of these structures. 
 
At the same time, this is also the problem of the remote investigation method. With this method, 
assumptions are made based on data from LiDAR data, literature, drone photos, etcetera. However, 
real proof of the existence of a structure at that location requires field research. Without this, it is 
impossible to say with certainty if the structure is really at that location, because this research is 
based on assumptions. It would therefore be desirable for the area to be surveyed at a distance using 
the current method prior to fieldwork. This would allow the structures to be validated during the 
field survey. 
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What did the Brandenburg Land Agency do to alter/restore the Hammerfließ to a more natural state, 
and how did this contribute to the natural value in this area?    
 
The Brandenburg Land agency has done the following to restore the Hammerfließ to a more natural 
state; flow paths have been extended and two new water loops have been constructed. In addition, 
new floodplains with loops have been created north of the Hammerfließ where the soil must be 
moisted. Low water channels through the floodplain are intended to keep the soil wet. Also, many 
culverts under roads have been replaced by bridges or free passages. Finally, the riverbed has been 
raised. It is striking that all adjustments were made on the northern side of the present Hammerfließ.  
 
Unfortunately, it is notable that agricultural fields through which the original paleo river Goila flowed 
could not be used for the restoration of the Hammerfließ. As a result, the adjustments have not yet 
had the desired effect, and the Hammerfließ still does not have a stable water level. 
 

Main research question  
   
How can the area around Baruth be mapped remotely with ArcGIS Pro by using LiDAR data, and - by 
using this mapping which traces of the paleo-river Goila (which was partly canalised into the 
Hammerfließ) can still be found there?   
 
In short, the use of LiDAR data in ArcGIS Pro for mapping the survey area is a very useful addition to 
the preliminary research of fieldwork. With this new technique, many new landscape structures can 
be identified. By using this mapping, traces of the paleo-river Goila have been found in strip 0, 1 and 
2. The traces of the paleo-river were found by use of the DEM and by the cross-sections which 
showed depressions in the landscape indicating the paleo-river. However, on the satellite images the 
paleo-river could not be seen and these traces cannot be validated using this method. For this, field 
research is a core requirement. The method used for the current study would therefore be a good 
pre-processing method, which could shorten the period of field research and improve the result. 
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7. Discussion 

 
The aim of this study is, as discussed earlier, to map out the geomorphological characteristics of the 
study area, without doing any field research. The research took place on different scale levels, 
namely macro, meso and micro level. As a result of this research three different maps of the research 
area have been made on the different scale levels. This research took place completely at a remote 
location, which has its advantages, but there are certainly points of discussion to be made about this 
research method and to what extent this is a substitute for field research is a part that will be found 
out in this research. This section of the study discusses what this research method is actually suitable 
for, and where it has shortcomings. 
 
First, positive to remote fieldwork has saved a lot of money compared to physical fieldwork. In the 
case of physical fieldwork, accommodation and food will have to be arranged, which would amount 
to about 300 euros (Romar, 2020). These costs have been lost, but the question is whether this 
outweighs the losses in terms of results by not having the fieldwork carried out. 
 
When mapping at the macro level, the current method was very useful and gave logical results. For 
example, the information produced by the Digital Elevation Model corresponded to the results of 
studies that did involve fieldwork (de Boer, 1995 & Juschus, 2001). For example, on the Digital 
Elevation Model there was a clear difference between the Baruther Sander and the Baruth Ice 
Marginal Valley. This difference in elevation made it possible to draw a clear boundary between the 
sander and the valley, in line with previous research (de Boer, 1995 & Juschus, 2001). 
 
The only discrepancy found between previous literature on macro level is the river terraces of the 
valley. In Gelderen, 2021 it is described that by applying an adjusted visualisation three river terraces 
can be clearly seen. However, Juschus, 2001, in his field research outlines that there are four river 
terraces. The question now is whether the newly found data by Gelderen, 2021 based on remote 
research is the right one, or whether this data is not accurate enough? A possible explanation could 
be that Juschus, 2001, in his research focused on the entire Baruth Ice Marginal Valley and found 
four river terrain layers in some parts, while in the current research area there are only three. 
However, this is a good discussion point to investigate in follow-up research where remote and field 
research is combined. 
 
At the meso level, the results of this method were in line with what was expected in the previous 
literature review. For example, during field research into dunes in the northern part of the Baruth Ice 
Marginal Valley by de Boer, 2000 a parabolic dune series was already described and visualised. The 
easternmost point of this dune series, called the Tütschenberge, is in the northern part of the 
present study area. These parabolic dunes with dune ridges can be clearly seen on the Digital 
Elevation Model created during this investigation. Here, the parabola dunes lie in exactly the same 
place as described in de Boer, 2000. The remote method gives additional evidence of the dunes 
examined in de Boer, 2000 and is very useful for this purpose. Snoek's (2016) thesis studied dune 
formation in the northern part of the study area (strip 1). Here, exactly the same parabolic dunes 
were drawn as found on the DEM in this study. The part of the dunes in the present study area 
(Tütschenberge) was formed just after the last Ice Age (Weichselian Ice Age) and is 11,850 years old 
(Snoek, 2016). This is another evidence for the presence of the dunes. Part of Snoek's (2016) thesis is 
field research. In short, as a result of the combination of the dune structures found on the DEM in 
this study, the dunes found by de Boer (2000) and Snoek (2016), it can be concluded that these 
parabola dunes are actually present. 
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Finally, an important point of discussion is that there has been intensive guidance from area expert 
Mr. Dr. W.M. de Boer, who gathered a lot of information by doing (field) research in this area and by 
guiding previous theses in this research area. He has also done a lot of research in the area himself 
and in the guidance provided information gained during fieldwork. Thus, if this guidance had not 
taken place, and thus information actually had to be obtained on its own without field research, this 
study would not be possible. 
 
In short, the key point is that the assumptions that can be made in research digitally at a distance 
during fieldwork must be validated to draw valid conclusions. Here, the combination of remote 
digital research and field validation provides a synergy. However, due to COVID-19, this combination 
was not possible. 
 
At the micro level, the method has added the most advantages, but also the most shortcomings. 
Starting with the added value. The remote survey with ArcGIS Pro and the incorporation of LiDAR 
data into a Digital Elevation Model (DEM) allowed for surveys with an accuracy of 5 decimetres and 3 
decimetres in height. This has ensured that structures that cannot be seen with the eye during 
fieldwork have been found. For example, the Relict Charcoal Hearts that were expected in the area 
(Wijkhuizen, 2018) were also found. The characteristic shape could be determined from literature 
and then traced in the current study area.  
 
However, for the detection of the Relict Charcoal Hearts, fieldwork is crucial. The structures of the 
RCHs are so small that other depressions on the surface make it look as if there is an RCH there. Only 
drilling during field research can prove the existence of an RCH. In the case of an RCH, charcoal 
remains will be found in the soil during the soil drilling test. It has been shown that in previous 
research, 50% of the assumed RCHs, based on research alone with ArcGIS, turned out to be an actual 
RCH after validation in the field (Romar, 2020). This is reason enough to state that field research is 
necessary. 
 
The RCSs were easier to identify than the RCHs, because the structures had greater height 
differences and were therefore better visible on the Digital Elevation Model (DEM). It is important to 
mention that the Russian former military training area Heidehof-Golmberg is located in the south of 
the research area and it is therefore likely that there are remains of these military actions. Literature 
research into the shapes of these remaining landscape structures makes it possible to map them out 
at a distance. However, the same argument applies here, that validation in the field is needed to 
confirm the assumption. 
 
The remote method works well for tracing paleo-rivers. The DEM has a z-value with an accuracy of 
0.3 m, which makes it useful for tracing of small depressions characteristic for paleo-rivers in the 
landscape. It is also possible to make a cross-section obtained from the DEM, on which these 
depressions are clearly visible. However, to be sure of a paleo-river, more evidence is needed. 
Indications can therefore be seen on the DEM and the cross section. However, this is only 
information based on height. Unfortunately, it was not possible to validate the paleo-river on the 
basis of soil type. This is possible because of the discolouration on the satellite photo, but this is not 
the case. It is possible to find out whether fluvial material is present deeper in the soil as evidence for 
the paleo-river. However, this also requires field research. 
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Another point of discussion when tracing paleo rivers are the cross sections. It is very difficult to 
accurately represent the small depressions in the landscape of about 50 centimetres in the cross-
section graph. The graph is very sensitive to irregularities in the landscape caused, for example, by 
roads with a greater height difference than that of the paleo-river. This changes the scale of the 
graph and the small depression in the surface of the landscape caused by the paleo-river cannot even 
be seen. 
 
The Dynamic Range Adjustment (DRA) has been used for tracing paleo-rivers. The DRA function 
adjusts the symbology of the DEM to the values in the image. The highest point in the image is given 
the reddest colour and the lowest point in the image the greenest colour. This ensures that small 
height differences are clearly visible and is therefore very useful when tracing paleo-river systems. 
This function was used in the production of figures 10 and 12. However, the DRA function is not 
carried through to the legend. It remains at the values of the entire DEM. This causes the greenest 
part in the map not to stand for a height of 37.12m above sea level and the reddest part for 178.52m 
above sea level, but for unknown values. Also, the function in ArcGIS Pro to adjust this was not found 
during this research. 
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Appendix B: 

Building an aprx project file for maps of the 

Baruth Ice-Marginal Valley in Brandenburg 

This workflow will go through the steps to generate an .aprx file for use in ArcGIS Pro with web services 

and local geodata, partly downloaded from the UvA Geoportal and/or from the Surfdrive for the 

Bachelor Project under supervision of Thijs de Boer. Part of the maps that we will insert/use are also 

to be found at: https://bb-viewer.geobasis-bb.de/ (=Brandenburgviewer) and at 

http://www.geo.brandenburg.de/lbgr/bergbau (= Bergbauviewer) and 

https://geobroker.geobasis-bb.de/ (general Site of Geobroker, the Internetshop of the LGB 

(Landesvermessung und Geobasisinformation Brandenburg), for Topographical Maps: 

https://geobroker.geobasis-bb.de/ 

WORKFLOW 

1. Start ArcGIS Pro. Check if you have the licenses for the extensions. You can do this by clicking 

project and checking under licensing. Check if you have the Spatial analyst, 3D analyst and 

Data Interoperability licensed. If not contact your ArcGIS manager = Thijs de Boer. 

 
 

2. Go back to the start screen > New > Blank Templates > Map. 

3. Create a New Project and call it ‘Bachelor_Research_Brandenburg_year_name’ (and check 

‘Create a new folder for this project’). 

4. In the Contents Pane, Right click ‘Map’ > Properties > in Tab General change the name of the 

Map to ‘Baruth EPSG 25833’. 

5. In the same dialog box, head to > Coordinate Systems. Click (activate) – if necessary - the 

rectangle beneath ‘Current XY’. In the Search box behind XY Coordinate Systems Available, 

type in 25833 and click <Enter>. The coordinate system ETRS 1989 UTM Zone 33N for XY will 

appear blue in the search results (the number 25833 is an international EPSG number for easy 

https://bb-viewer.geobasis-bb.de/
http://www.geo.brandenburg.de/lbgr/bergbau
https://geobroker.geobasis-bb.de/
https://geobroker.geobasis-bb.de/gbss.php?MODE=GetProductInformation&PRODUCTID=51f27fc3-b9b6-4e64-b299-ea877d90915d
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search of coordinate systems, like you used 25830 for Murcia in Spain). For more information 

on this coordinate system: ETRS89 / UTM zone 33N - EPSG:25833. Do not close the dialog box. 

6. In the same dialog box, click ‘Current Z’. Type in the search box 5783 and click <Enter>. This 

will show you the DHHN92 vertical coordinate system (these refer to the height or Z-values in 

your .las-datasets). For more information on this coordinate system: DHHN92 height - 

EPSG:5783. Click OK. 

 
  

https://epsg.io/25833
https://epsg.io/5783
https://epsg.io/5783
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7. Click on the Insert window > Connections > New WMS Server. 

8. Add WMS Server (make sure to also copy the question mark ‘?’): 

https://isk.geobasis-bb.de/ows/dtk25farbe_wms? 

(This is a very actual kept topographical web map WMS, German scale 1:25.000). 

 
9. In the Main Ribbon (top most ribbon), click View. Open a Catalog Pane. 

10. In the list, Click Servers, so the new WMS connection shows up. 

11. Expand the WMS connection (click the small triangle sign in front of the service name) 

12. Drag and drop the WMS-DNM link WMS BB-BE DTK25 Farbe to your map. 

13. Zoom to Baruth/Mark, set your Map scale at 1:100.000 and keep Baruth in the middle of your 

map (the northern part of Golssen in the south should still be visible on your map). This 

bookmark makes it easier for you to go back to this overview later if wanted. 

14. Choose Map > Bookmarks > New Bookmark > Name: Baruth 1:100.000. 

15. Now you can remove the ‘World Topographic Map’ and the ‘World Hillshade’ from your TOC. 

16. In the same manner, add these WMS from https://geobroker.geobasis-bb.de/ (there are also 

WFS services for these maps, of which we will use some of them later) to your WMS Server 

connections and to your map: 

https://isk.geobasis-bb.de/ows/dtk10farbe_wms? (This is a topographical web map 1:10.000). 

https://isk.geobasis-bb.de/mapproxy/dtk25farbe/service/wms? (This is a topographical web 

map WMS, very quick, because it is cached, German scale 1:25.000). 

17. Add also the WMS 
https://inspire.brandenburg.de/services/bokarten_wms? (this is a soil map) 

https://inspire.brandenburg.de/services/boartsubstr_wms? (a substrate map) 

https://isk.geobasis-bb.de/ows/dop20c_wms? (these are aerial images in 20 cm resolution) 

18. Add also the WMS https://isk.geobasis-bb.de/ows/dgm_wms? from the website DGM - 
Produktmetadaten | Geobroker - Der Internetshop der LGB (geobasis-bb.de) to your Catalog 
Pane and your map. This is a Digital Elevation Model (DEM) or in German: Digitales 
Geländemodell (DGM). 
 

https://isk.geobasis-bb.de/ows/dtk25farbe_wms
https://geobroker.geobasis-bb.de/gbss.php?MODE=GetProductInformation&PRODUCTID=51f27fc3-b9b6-4e64-b299-ea877d90915d
https://isk.geobasis-bb.de/ows/dtk10farbe_wms
https://isk.geobasis-bb.de/mapproxy/dtk25farbe/service/wms
https://inspire.brandenburg.de/services/bokarten_wms
https://inspire.brandenburg.de/services/boartsubstr_wms
https://isk.geobasis-bb.de/ows/dop20c_wms
https://isk.geobasis-bb.de/ows/dgm_wms
https://geobroker.geobasis-bb.de/gbss.php?MODE=GetProductInformation&PRODUCTID=488a2b53-564f-43eb-88ec-0d87bb43ed20
https://geobroker.geobasis-bb.de/gbss.php?MODE=GetProductInformation&PRODUCTID=488a2b53-564f-43eb-88ec-0d87bb43ed20
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DSM = Digital Surface Model = would follow the highest points of the DEM. 
 

 
 
 

19. Save your project. Do this regularly, in case the program crashes you have a recent copy at 

least. Even better is to give your .aprx a new version name, e.g. the date of the day of last edits. 

20. It can come in handy that you have the tile numbers and tile borders at hand. We will add a 

WMS and a WFS for this purpose. Each with advantages and disadvantages. 

21. Add the following WMS to you map: https://isk.geobasis-bb.de/ows/blattschnitte_wms? 

This WMS contains the tiles of maps and LiDAR data and according numbers (‘Blattschnitte & 

Kachelung’). Add the layers ‘Kachelung 2x2 km’ and ‘Nummern der Kachelung’ to your TOC as 

top layer. Hint: tile numbers will not be shown when zoomed out beyond about 1:75.000. 

https://isk.geobasis-bb.de/ows/blattschnitte_wms
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22. Your TOC, Catalog and map will now / should now look like (Baruth in the middle of your map): 

 
 

23. The WMS of the Tile numbers and tile boundaries is not very clear (a bit blurry). Add the 

alternative Webservice, as a WFS to your Catalog Pane: Insert > Connections New WFS Server. 

https://isk.geobasis-bb.de/ows/blattschnitte_wfs? Drag and drop the layer ‘Kachelung 2x2km’ 

to your map. 

24. It is possible export the features of this WFS from the server in Brandenburg to your 

geodatabase, because a WFS streams all the points, lines and polygons it contains. 

Right-click on Kachelung 2x2 km in your TOC > Data > Export Features. Call the new feature 

class ‘LASTilesBoundariesBrandenburgWithTileNumbers’. Check under ‘Environments’ that 

you use the right projection (do this always in these kinds of dialog boxes in ArcGIS Pro). 

https://isk.geobasis-bb.de/ows/blattschnitte_wfs
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Zoom to layer. You will see that only in the western part of Brandenburg the webservice is 

shown. Let’s hope, this is only a temporary problem! 

25. The las files that you will use in this Bachelor Research were generated from the original xyz-

files that were bought by the UvA from the LGB = ‘Landesvermessung und 

Geobasisinformation Brandenburg’ (https://geobasis-bb.de/lgb/de/) with the program 

LAStools, with the command (sub program) txt2las (C:\LAStools\bin\txt2las.exe). In this 

conversion, the coordinate systems EPSG 25833 (ETRS 1989 UTM Zone 33 North = horizontal) 

and EPSG 5783 (DHHN92 = vertical) were implemented already, so you don’t have to do that 

yourself. But the LAStools can also come in handy for other conversions and creation of Land 

Surface Parameter products (e.g. hillshade, aspect, etc.), so please copy the folder LAStools as 

a whole from the Surfdrive under the folder Software to the C-drive of your laptop or home 

computer. The tools under the bin directory should work immediately, without additional 

installing. Some tools have a windows interface, some others have a command line interface 

and some tools have both. 

https://geobasis-bb.de/lgb/de/
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26. You should have received access to files and folders on the Surfdrive of Thijs de Boer: 

BSc Research Horstwalde 2020 en 2021 - Bestanden - SURFdrive 

One of those folders, beneath ‘Data’ is: ‘LiDAR Tiles 2021’ and it contains 6 strips (‘stroken’) 

with each 5 las files, covering each 2x2 km. So each strip is 10 km N-S and 2 km E-W. 

Strips 1 – 4 are assigned to you personally. N.B.: Strip 0: has been worked on in 2020 by Stef 

Zuidervaart and will be used for alignment purposes. Strip 5: has not been worked on in 2020 

and will be used for alignment purposes in 2021. 

 

Strip Name Strip Name student 

0 Schöbendorf Stef Zuidervaart (2020) 

1 Paplitz Jaap Wesselman 

2 Baruth Aletta Melger 

3 Klein-Ziescht Hein van Gelderen 

4 Klasdorf Joost Bakker 

5 Glashütte Extra (for alignment) 

 
 

27. The folder ‘LiDAR Tiles 2020’ contains the 49 that were bought  by the UvA before 2020, with 

a shapefile of the bounding box around those 49 tiles and another shapefile with the bounding 

box of the 30 tiles that were used by the students in 2020. And it contains sub-folders with a 

DEM per tile. The folder ‘LiDAR Tiles 2021’ also contains an overview shapefile of the 6 strips  

that will be used in 2021. Add all of the overview shapefiles to your GDB. Right click your GDB 

select import feature class. Don’t forget to name your output feature class. 

a. Beware: a shapefile consists of several files (not only .shp but also .dbf, .sbn, and so 

on) 

https://surfdrive.surf.nl/files/index.php/apps/files/?dir=/Bachelor_Research/BSc%20Research%20Horstwalde%202020%20en%202021&fileid=6981435475
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b. If you’re getting an error message you have to define a projection: 

ETRS_1989_UTM_Zone_33N (=EPSG 25833). 

Change the symbology to a 100% transparency/change the color type to black or blue or red 

outline (border). 

N.B. the overview shapefile was made by using the tool ‘lasboundary.exe’ to extract the 

outer boundary as a shapefile, with the command (see to it that you also fill in the projection 

tab): 
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28.  

   
Make the shapefiles transparent (hollow) and use blue or black (tiles 2020) or red (tiles 2021) 

outline. See screen shot of map above. Now right-click on ‘boundaryall64lastiles2014tm2021 

and ‘ zoom to layer’. Add an extra zoom layer of 1:90.000 in the box in the lower left corner: 

 
 

29. Make a bookmark for this layer and another one for the ‘boundary30lastilesBaruth2021’ layer. 

30. From the Surfdrive, download your assigned 5 LiDAR tiles. Field strips are assigned, see the 

map of the field strips on page 5 of this document. 

31. Create a new las dataset in the Catalog Pane or use the tool Create a Las Dataset and give it 

the name StripNumberYear2021.lasd 

a. Add your personal LAS files to the dataset. 

b. Make sure to calculate statistics. 

32. Assign a horizontal coordinate system to your personal las dataset: ETRS 1989 UTM Zone 33N 

= EPSG 25833. 

33. Assign a vertical coordinate system to your personal las dataset: DHHN92 = EPSG 5783. 

34. Use the tool ‘Build LAS Dataset Pyramid’ for your personal las dataset. 

35. Add your las dataset to the TOC. 
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36. Add an extra zoom layer of 1:9.000 in the box in the lower left corner. 

37. Zoom in on one of your las tiles at a scale of 9,000. You should get a similar map view as the 

images below: 
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38. Make a visualization of the las dataset on the base of the elevation. In order to do this you 

need to click one of the Lasd datasets in your TOC. Next click the appearance header (on the 

top, in the main ribbon) and click on Symbology > Symbolize your layer using a surface > 

Elevation. By doing this your dataset will create intervals. It should look similar to the image 

below. 
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39. Instead of the 9 default classes we would like to have 24. Head over to symbology by 

right clicking the PersonalLasDataset in TOC. From the symbology screen change the amount 

of classes to 24. ArcGIS Pro should assign proper spacing by itself. Choose a proper color 

scheme. 

 
 

40. Add the following (scanned, already georeferenced and very detailed) Military Topographical 

Maps 1:25,000 from the 1980’s: Surfdrive > Data > Brandenburg > 02-Voltooide kaarten > 

TOP25 > 

From west to east and north to south: 

Luckenwalde: N-33-135-C-d_Luckenwalde_1989Ausgcrop_UTM33N.tif 

Sperenberg: N-33-135-D-a_Sperenberg_1989Ausgcrop_UTM33N.tif 

Stülpe: N-33-135-D-c_Stuelpe_1989Ausgcrop_UTM33N.tif 

Wünsdorf: N-33-135-D-b_Wuensdorf_1989Ausgcrop_UTM33N.tif 

Paplitz: N-33-135-D-d_Paplitz_1989Ausgcrop_UTM33N.tif 

Gross-Ziescht: M-33-3-B-b_Gross-Ziescht_1986Ausgcrop_UTM33N.tif 

Teupitz: N-33-136-C-a_Teupitz_1989Ausgcrop_UTM33N.tif 

Baruth: N-33-136-C-c_Baruth_1989Ausgcrop_UTM33N.tif 

Golssen: M-33-4-A-a_Golssen_1987Ausgcrop_UTM33N.tif 

Add more maps from this and adjacent folder(s) if you need other map sheets. 
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41. Try to combine these topographical maps with the lasd dataset(s), like in this map: 

 
 

Try to adjust the Elevation Range to 
the values (heights) that are 
available in your map frame at that 
moment. 

 
 

In this way, a former parabolic dune, just east of Paplitz and 
just north of the Dutch-owned dairy farm on the edge of the 
Niedere Fläming, is revealed. Check the bow-formed light-
pink/blueish colors below the 53,8 m mark on the map 
fragment below. 
 

 
 
 

 

 

 

42.  New map of area of Horstmühle (here in ArcMap 10.x and with 50% transparency): 
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43.  
44. We will now create two cross sections (you will use this often in your research). 

See for a thorough workflow video: (542) 3D Profiling and Layout in ArcGIS Pro - YouTube 

This video explains some of the steps for creating 3D profiles of a Digital Elevation Model and 

adding a 3D View, 2D view, and profile charts to an ArcGIS Pro layout. 

This method works both on DEMs and on las datasets. 

45. So first, a DEM of our research area is needed. 

You can make one by using the LAStools and a command like (this will be generated if you use 

the windows interface and will be shown before you hit START): las2dem -cpu64 -lof 

file_list.15536.txt -merged -elevation -odir "D:\Temp" -otif -etrs89 -utm 33north -

vertical_dhhn92. 

My (Thijs’) computer at home is not able to process all 30 las tiles (=6x5) we use in 2021 at 

once. So I made a DEM of the las tiles of Strips 0+1+2 and a DEM of the las tiles of Strips 3+4+5. 

It is possible to mosaic those 2 DEMs (‘glue them together’) later. The two DEMs are available 

on the Surfdrive. 

 
46. Mosaic both DEMs together in ArcGIS Pro or in the LAStools. 

47. Add the new mosaic to your map. In the following text you may use this DEM or a las dataset 

of the research area (both options work). The text below is based on using a las dataset. See 

to it that (in case you use the las dataset) you use the point symbology (use elevation as points 

instead of surface, change Symbology if needed) with no stretching (see screenshot in the table 

https://www.youtube.com/watch?v=QaDNX34EX2o
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below). Use ‘Reset Legend Elevation Range’ by right-clicking the layer under consideration in 

your TOC. This will stretch your legend color palette to the values shown in the map window 

you are zoomed in at this moment. 

48. Make two new line feature classes (Profile1 and Profile2) in your geodatabase (see video at 

minute 6:30). Add them to your TOC (8:00). Remember: these feature classes are still empty. 

49. Click Edit in the Main ribbon > Create (8:30) > Profile1 > digitize a line on your map where you 

want to have your first cross section. Do the same for Profile2 > line (about) perpendicular to 

Profile1. See where to place best in your situation (depending on topography and what you 

want to research). Do not forget to save your edits. In the screenshot below I want to research 

a possible (parabolic) dune. 

 

 
 

50. Search for the tool ‘Profile’ in your Geoprocessing window (Analysis > Tools > Find Tools) 

(11:06). 

51. Choose Input Line Features: Profile1. 

52. Choose for Profile ID Field: OBJECTID (this video is the only resource I found on the internet 

which tells you so…). 

53. Choose DEM resolution: Finest (see table below, screenshot to the right). 

 

  



  

 

     47 

 
Use Elevation as points if you use a las dataset 
for making a profile 

 
Choose for Profile ID Field: OBJECTID 

 

54.  In your TOC, rename your ‘Output Profile’ To ‘Output Profile1 North-South’ (12:20). 

55. Do the same steps in the dialog box Profile for Profile2 and name the output profile ‘Output 

Profile2 East-West’. 

56. Change the symbology of these two profile lines as you like (line thickness, color, etc.). 

57. Now we want to create a chart of our two profiles (14:30). 

While ‘Output Profile1 North-South’ or ‘Output Profile2 East-West’ is selected, go to Feature 

Layer (main ribbon) > Data > Create Chart > Profile Graph (at the bottom of the drop down 

menu). This will create a cross section type of graph. Fill in the Properties as needed. Use (in 

the Axes tab) meters in the x- and y-axes and use meaningful names (in the General tab). 

You can export each profile graph as a graphic and use it in your BSc thesis! 

58. We will now switch to 3D (18:30) in making a 3D scene. In Main Ribbon go to View > Convert 

> To Local Scene. Use the new scene. 

59. In your TOC, under Elevation Surfaces, right-click Ground > Add Elevation Source > add your 

DEM of our research area (DEM15lastilesBaruth2021Strip012.tif or 

DEM15lastilesBaruth2021Strip345.tif) 
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60. Remove te WorldElevation3D/Terrain3D layer from your TOC. 

61. Adjust the 3D navigation wheel (22:00). 

 
62.  If you want to exaggerate the relief, in your TOC activate Ground. Go to the Main Ribbon > 

Appearance > Vertical Exaggeration > change from 1 into 2 or bigger. 
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63.    ============ tot hier is deze handleiding bijgewerkt op maandag 15 maart 2021 ===== 

  ============ hieronder verder op maandag 29 maart / dinsdag 30 maart 2021 ===== 

64. Nog beschrijven: toevoegen gescande en gegeorefereerde kaart uit Diss. De Boer (1992). 

Tif in kaart 

Naar imagary in bovenste band 

Naar georeference 

Ongeveer het goede deel van kaart in beeld 

Fit to display 

Uitzoomen om te kijken waar je bent en waar de kaart is 

Weer fit to display 

Tot ie bijna goed ligt 

Zoek herkenbare punten op beide 

Die punten verbinden (minstens 10 a 12, verdeeld over kaart) met second order 

Tussendoor link table opslaan.  

Opslaan als tif met georef in naam 

 

65. New  

a. Edit-> create 

b.  

66. For detailed analysis of the terrain, we need a DEM at high resolution, in this case: 0.5 meter. 

Use the tool LAS Dataset to Raster (a DEM is a raster) in ArcGIS Pro or use the LAStools (see 

steps below. From header appearance click dropdown menu LAS points and select ground. 

Next use the tool LAS Dataset To Raster. In the menu set sampling Value to 0.5 meter and 

choose Void Fill Method Linear. 

67.      

68. LAS TO DEM in the LAStools: use the LAStools las2dem.exe to convert a .las file to a DEM 

(Digital Elevation Model).  

69. Stuk van vorig jaar (2020) nog onbewerkt hier onder. 

** DRA not working, zo kun je op hele kleine schaal hoogte verschillen zien (nog doen) 
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70. In the 2D map: Select PersonalLasDataset in your 2D map,  click appearance 

a. Increase the Display limit to 5000000 ( or more!). This limits the number or points used 

in the traingulataion of the LAS Dataset layer surface.  

b. Slide the Density bar to max (fine point density). This option controls the density of 

points enforeced by the LAS datasetDensity 

c. Set the full resolution scale to 1:1000. This scale is used to control when the LAS 

dataset will render itself without thinning, using 100 percent of the LAS points. It is 

used when the map scale is equal to or greater than the scale you specify. The point 

limit is still honored though, so if the number of estimated points for the current extent 

exceeds the limit, the LAS dataset will thin itself and not draw using all the data. When 

this occurs, an asterisk is displayed next to the data percentage listed for the layer in 

the table of contents. When the map display scale is less than the full resolution scale, 

thinning will occur based on the setting of the Point Density slider bar. 
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71. Create TINs of your point cloud. This is not described well in this explanation but might be 

useful for us. So please try and guide us through this process here: 

 

72.  How to create a cross section 

a. Search in Geoprocessing for the Profile tool 

b. Create your own line using the pencil symbol 

c. Set DEM Resolution to 10m 

d. Click Run  

e.  Click in the TOC on the Output Line and click on create charts, next to the feature layer 

f. In the dropdown menu, choose Profile Graph 

 

73.  Now it is possible to draw a cross section profile: 

 

Lange Horstberge: looks more like a transverse dune then a longitudinal dune ! 

Research question: is this the case for the whole of the Lange Horstberge ? Or just a part ? 
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74.  Add  a lithographic map: see WMS at the beginning of this document. 

 

 


